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CHEMICAL SYSTEMS 

Introduction 
In this chapter we will use Berkeley Madonna to model systems of chemical reactions. For 

simple systems the Flowchart is an adequate interface. However, for systems with more than a 

few reactions the equation interface quickly becomes easier and faster.  

If you try and construct the Flowchart for the 

water formation reaction above, you will see 

that, even for this simple reaction, it is 

cumbersome and not very intuitive. This is 

because each reactant has its own reservoir and 

flow, but they cannot be interconnected into an 

intuitive diagram such as this one  

This is a limitation of the Berkeley Madonna 

Flowchart which is designed to keep track of 

conserved quantities such as mass or number 

(e.g. moles). But chemical reactions convert 

one substance to another according to the 

stoichiometric coefficients, and so mole 

numbers are not conserved except in the 

special case of unimolecular reactions with unit 

stoichiometric coefficients. However, such 

models are an important subclass which we 

will deal with first. In the Appendices we use 

the bimolecular reaction A + B  C to 

illustrate the difficulties in modeling reactions 

with the Flowchart. 

Linear reaction chains: Markov models 
A commonly encountered situation is a chain of reservoirs where transitions, or flows, are 

unimolecular and have unit stoichiometry: 

Equation 1.   S1
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The Flowchart corresponding to Equation 1 is shown in Figure 1 along with the equations of 

motion. 
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Exercise. GRAPH THE SOLUTION FOR THE 4-STATE REACTION CHAIN IN Figure 1.  

  

 

Figure 1. Linear chain of compartments modeled by Equation 1. 

Linear chains of compartments can be used to model many situations other than chemical 

reaction chains. For long chains, the Flowchart is unwieldy; however, we will see later that 

Berkeley Madonna’s Array notation makes handling long chains easy.  

Using the chemical reaction module 
Flowcharts for complex reaction schemes are confusing, so we need a better way of generating 

the model equations. For modeling systems of mass action kinetics, Berkeley Madonna has a 

simple interface that enables one to set up and solve complicated reaction schemes quickly and 

easily using ordinary chemical notation. 

1. Open the Chemical Reactions dialog by selecting it 

from the Model menu: Modules popup (Figure 

6a).  

2. Using ordinary chemical notation, enter the first 

reaction in the Reactants: and Products: boxes 

(Figure 6b). 

3. Enter numerical values for the forward rate 

constant, Kf, and the reverse rate constant, Kr, as 

shown. 

4. Click Add, and the reaction will be recorded in the Reactions: list. 

5. Enter the Initial Concentrations. 

6. Click OK and the equations appear in the Equation window. 

{Reservoirs} 
 d/dt (S1) = - J1 

 INIT S1 = 10 

 d/dt (S2) = + J1 - J2 

 INIT S2 = 0 
 d/dt (S3) = + J2 - J3 

 INIT S3 = 0 

 d/dt (S4) = + J3 
 INIT S4 = 0 

 

{Flows} 
J1 = k12*S1-k21*S2 

J2 = k23*S2-k32*S3 

J3 = k34*S3-k43*S4 

{Functions} 
k12 = 2 

k23 = 2 

k34 = 2 
k21 = 1 

k32 = 1 

k43 = 1 
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 You can use the check boxes in the dialog box to control how much of the model equations are 

displayed in the Equation window. Note that the equations are highlighted indicating that you 

cannot edit them directly. However, double-clicking in the highlighted area re-opens the dialog 

box for editing. When a reaction is changed it is entered with the Modify button. A summary of 

the Chemical Reaction Module procedure is always available under the Help > How do I… 

menu. 

 

Figure 2. Chemical reaction module dialog box and equations.  

Exercise: Simulate the 4-compartment reaction chain for 700 time units with an initial 
condition of 100 in the first compartment and the other compartments 
initially empty, as shown in Figure 2. Set all reaction rates = 0.005. 

Introduction to parameter plots 

Consider the simple function y =  ymax*x/(b + x), ymax = 1, b = 1. You can easily plot this in 

Berkeley Madonna by typing in the Equation window as shown in Figure 3a. You could 

investigate how the shape of the curve changes when you vary, say, the parameter b by 

constructing a Slider. However, you can summarize many manipulations of the slider by making 

a plot of, say, the maximum value of the curve (ymax) as a function of the parameter b. Go to the 

Parameter Plot… dialog under the Parameters window and choose b as the parameter, and the 

maximum value of y as the value plotted (see Figure 3b). 

Exercise. Plot the logistic equation of population growth: dn/dt = an - bn2, where n(0) = 
1, using sliders to vary a and b. Explain what happens when b > a. Now 
make a parameter plot of the final population for 1  b  10 when a = 5.  

Optional: Look up the DELAY function in the Equation Help and write the 
delayed logistic equation dnd/dt = and(b - nd(t - T)2). Make a slider to vary 
the time delay, T, and watch what happens as T increases from zero. Make 
a parameter plot of the oscillation amplitude as a function of the delay, T. 
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Figure 3. Plotting a function and making a Parameter plot. 

Cooperative Binding of Oxygen to Hemoglobin  

Binding of O2 to hemoglobin (Hb) of red blood cells increases the O2 carrying capacity of the 

blood by a factor of nearly 70. However, the binding properties must be delicately balanced so 

that Hb binds O2 in the lungs and releases it in the tissues. The following model captures some of 

the major characteristics of this reversible binding reaction. We simulate the time course of 

binding when totally deoxygenated Hb is suddenly exposed to a constant concentration of O2. In 

this case the hemoglobin binds four O2 molecules sequentially: 
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Exercise. Use the Chemical reaction module to construct the model for this process using the 

measured parameter values shown in Table 1 

kf [Mol-1•msec-1] kr [msec-1] 
Residence time [msec] 

 

kf1 = 2,100 kr1 = 0.03 Hb = k f 1 O2[ ]( )
1

= 47.6 

kf2 = 8,400 kr2 = 0.06 
 

kf3 = 12,600 kr3 = 0.09 HbO4 = kr2 + k f 3 O2[ ]( )
1

= 5.4  

kf4 = 40,000 kr4 = 0.04 HbO6 = kr3 + k f 4 O2[ ]( )
1

= 2.0  

… … 
HbO8

= k
r4( )

1

= 25.0  

Table 1 Parameters for Hb-O2 dissociation. Residence time  is calculated for [O2 ] = 

10-5 M 

Note that the Reaction module inserts O2 as a variable; to keep it constant, insert the equation 

d/dt (O2) = 0 after the module equations. (Berkeley Madonna sets all quantities to the last values 

entered in the Equation window.) Use INIT O2 = 10-5, INIT Hb = 10-4. At the beginning of the 

program use the following integration scheme and variables: METHOD STIFF, STARTTIME = 

0, STOPTIME = 500, DTMIN = 1e-6, DTMAX = 1, TOLERANCE = 0.01. 

Plot the O2 dissociation curve by running a Parameter Plot with INIT O2 on the x axis from O2 

= 10
-6

 to 3 10
-5

. Use about 30 points spaced geometrically, and Plot FINAL values on the y-axis.  

HbO2 = kr1 + k f 2 O2[ ]( )
1

= 8.8
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Figure 4. Hemoglobin model (a) Parameter window. (b) O2 dissociation curve of FINAL 

HbO4 vs. INIT O2. 

The O2 dissociation curve reflects the cooperative binding of O2: binding of each O2 molecule 

induces a conformational change making binding easier for the next molecule. The curve is flat 

at very low O2 concentrations because binding the first oxygen is difficult. Binding the second, 

third and final oxygens are progressively easier, so that the curve changes rapidly within the 

physiological range of O2 concentrations encountered in arterial and venous blood. 

Consequently, Hb serves as an effective buffer for the O2 concentration in the blood. This 

cooperative behavior is apparent from the model parameters in Figure 4: the magnitudes of the 

rate constants for the forward reactions, increase progressively as more O2 molecules bind.  

The parameter table also shows that the intermediates, HbO2, HbO4,and HbO6, have short 

lifetimes (residence times  ~ 1/kf) when compared to the initial, Hb, and final, HbO8, reactants. 

Moreover, plots of these intermediates against time shows that their concentrations rarely rise to 

significant proportions. These considerations suggest the reaction scheme can be approximated 

by ignoring the intermediates and, since the entire reaction is fast, assuming the whole system is 

in equilibrium i.e. nO2 + Hb  HbO8 

where n = 4. The solution to this chemical equilibrium is:  

Equation 2 [HbO8
] = [HbO

8
]
max

[O
2
]
n

K
50

n
+ [O

2
]
n

 

The validity of this approximation can be evaluated by curve fitting Equation 2 to the results of 

the original simulation. To do this follow these steps: 

1. Activate the graph window showing the O2 dissociation curve obtained by the 
parameter plot. Use the Chemical Reaction module using the parameter values in 
Table 1.  
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2. Click on the Table button on the graph toolbar to obtain a numerical tabulation of the 
simulation results. The table should contain only two columns: (INIT O2, HbO8). If 
there are other data on the table remove them.  

3. Save the table. (Select (File >Save Table as… )  

4. Close the model and open a New model (Select File> New ) 

5. Import the tabular data that you just saved as a new dataset (Select File> Import 

Dataset ) 

6. Type Equation 2 into the equation window (omit the square “concentration” 
brackets). Use the RENAME command to re-label the x-axis to O2. 

7. Set STARTTIME = 1e-6, STOPTIME =3e-5, n=4, HbOmax = 1e-5, and K50  = 1e-5. 
Find the best fit for the parameters HbOmax, and K50. 

The fit is a fairly reasonable approximation. The advantage of using it over the original scheme 

is that we have an explicit expression for the result, so that the number of computations is 

dramatically reduced. Most importantly, the number of unknown parameters has been reduced 

from eight to two! 

An even better approximation is suggested by noting that the plot of Equation 2 clearly has a 

long delay, and then rises faster than the original data. In other words the sigmoid shape of the 

approximation is more pronounced than the data. This indicates that the cooperativity within the 

original reaction scheme is not complete. We can accommodate this feature by relaxing our 

restriction on the parameter n and allowing it’s value to be determined by the data. To do this, 

refit Equation 2 to the results, but this time allow all three parameters HbOmax, K50, and n to vary. 

This fit is excellent with a value of n = 3.2. In this type of reaction, the fitted value n, is called 

the Hill Coefficient and is often used as a measure of a reaction’s cooperativity; the larger the 

value, the more the cooperativity (with n = 1 there is no cooperativity). Of course, the moment 

we depart from n  4, we are abandoning the model. In this case (n  4 ) becomes an empirical 

equation that is very useful for describing cooperative reaction data, but its physical 

interpretation is lost. 

Although our results capture the primary features of the O2 dissociation curve, it should be noted 

that the rate constants were determined using a purified preparation of sheep Hb at room 

temperature (15 20°C) and at pH 9.3. Therefore, we cannot expect the results to apply directly to 

physiological conditions of oxygen transport in normal mammals. In fact, the oxygen affinity 

predicted by these rate constants is much too strong so that the whole curve is shifted to the left. 

Hb under these conditions would not work; it would pick up O2 in the lungs but wouldn’t release 

it in the tissues. Raising the temperature, increasing the acidity, and incorporating normal 

amounts of DPG (2,3, diphophoglyceraldehyde) in the blood all lower the O2 affinity 

substantially, pushing the dissociation curve back towards normal. It should also be noted that 

our model has not taken account of the numerous conformational changes (usually denoted 

‘Tense’ and ‘Relaxed’) that occur with each stage of binding. 
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Michaelis-Menten kinetics: Fast and slow variables 

Stiff  systems 

One of the most important methods of simplifying a 

complicated system is to separate the processes into 

‘fast’ and ‘slow’ variables. The term arose from 

mechanical systems where ‘stiff’ springs respond 

very fast, while weak springs respond much more 

slowly. In the system shown to the right, two bodies 

are suspended in a very viscous fluid by stiff and 

floppy springs. (The viscous drag force on each is 

v1 and v2, where v1,2 = dz1,2/dt is the vertical 

velocity.) Then the displacement, z1(t) of the upper 

body, can be broken into an initial ‘fast’ regime, 

followed by a long-time ‘slow’ regime.  

In many situations we care only about the long-time 

behavior, not the initial transient,. This is frequently the 

case in biochemical systems, where some reactions are fast 

and others are slow. The classical example is the Michaelis-

Menten system, which we study below. 

  

Exercise. Consider the simple system:  

d/dt (x) = y - 2*x 

INIT x = 1 

d/dt (y) = -100*(y - x) 

INIT y = 0 

 

We can rewrite the equation for y as: dy/dt = x  y, where  = 1/100 is the time 

constant. Because  is small, y(t) rises very fast at first, then settles into the same 

decay rate as x.  
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Figure 5. A ‘stiff’ system. The ‘stiff’ variable, y, has an initial rapid rise, while the ‘soft’ 

variable, x, dominates the long-time motion. 

Use the STIFF solver with DTMIN = 0.01 and DTMAX = 0.5 to solve the system. 
Notice that y(t) rises very fast at the beginning (zoom in and see!), and thereafter 
changes slowly, along with x(t).  

Suppose y changed so rapidly that it was always near its steady state: dy/dt = 0. 
Then you could solve the second equation for y = x and substitute it into the first 
equation for x, so that it became dx/dt = -2x+x = -x. To see how good this 
approximation is, define a third variable, z by dz/dt = -x, x(0) = 0, and plot it along 
with x and y.  

Now solve the same system using the Euler method: in the Parameter window, 
select EULER from the drop-down menu. Show the data points by clicking the (•) 
button on the Graph window and see how many more steps Berkeley Madonna  
has to take to get a solution. 

The STIFF (Rosenbrock) algorithm deals with the problem of fast and slow variations by looking 

at the slope of the solution. If it is large, then the step size is decreased, and if the slope is small 

(so that the solution isn’t changing very fast) then the step size increases. There is no hard and 

fast ‘rule’ of when a stiff solver is better. If you see that there are fast and slow variables, try it 

out to see if it decreases the computation speed and/or the number of step. 

Enzyme catalyzed reactions can be stiff 

Simple enzyme catalyzed reactions obey the 

Michaelis-Menten (MM) kinetic equations: 

Equation 3 E + S
k
1   
k
1

   C
k
2   E + P   

where E is the enzyme, S the substrate, P the product, and C  E S, the ‘enzyme-substrate 

complex’. Many other kinetic systems obey the same reaction scheme; for example: 
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Membrane Transport Carrier, C: C
memb

+S
in

k
1

   
k

1

   C
memb
S

k
2

   C
memb

+ S
out

 

Ligand-Receptor Binding:   R +S

k
1

   
k

1

   RS
k
2

   Action  

Exercise: Use the Chemical Reaction module to generate the differential equations for 
the MM reaction scheme: 

Equation 4 (a) Enzyme: 
dE

dt
= k

1
C + k

2
C k

1
E S  (c) Complex: 

dC

dt
= k

1
E S k

1
+ k

2( )C  

  (b) Substrate:
dS

dt
= k

1
C k

1
E S   (d) Product: 

dP

dt
= k

2
C  

Not all of the differential equations are independent. Since the total amount of enzyme is 

constant: E + C = ETotal; so C can be eliminated from the equations . Also, the last equation for 

P(t) is completely determined once C is known, so it is superfluous. Therefore, the four 

differential equations can be reduced to only two independent differential equations. 

Exercise: Solve the equations using the parameters given in Figure 6 using the Euler 
and Runge-Kutta methods with DT < 0.01. Then switch to the Rosenbrock 
(STIFF) solver with DTMIN = 1e-6, DTMAX = 1, DTOUT = 0, and 
TOLERANCE = 1e-4 (Press 1997). Use the Show Data button (•) on the 

graph to compare how efficient this integration method is to the Euler and 
Runge-Kutta. Berkeley Madonna shows how many time steps it took to 
solve the equations in the upper left of the graph. 

The graph of the solution shown in Figure 6 shows that there are two ‘time scales’: (i) a fast time 

scale wherein C is in a steady state at all levels of S (Figure 6c), and (ii) a slow time scale 

characterizing the appearance of the product (Figure 6d).  
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Figure 6. The Michaelis-Menten equations using the chemical reaction module. (a) Module 

window, (b) Equations; (c) Short time graph showing the initial rapid rise of the 

complex C = ES and the gradual rise of P and fall of S. (d) Long time plot showing 

the rise of P and fall of S; C is also falling gradually as substrate is consumed. 

When the concentration of the complex is nearly constant, and we can set dC/dt  0. Then C can 

be eliminated so that the system reduces to a single equation for the velocity of the reaction, v = -

dS/dt = dP/dt: 

Equation 5    v =
v
max
S

K
m
+ S

      

where vmax  k2Etotal, Km = (k-1 + k2)/k1.  

The function v(S) is the Michaelis-Menten hyperbola. Km is the Michaelis constant. It 

approximates the dissociation constant only when  k-1 >> k2. The value of S when the velocity of 
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the reaction is half its maximum, Vmax, and the initial slope of the v(S) curve is Vmax/Km. Km is a 

dissociation constant: Km = krelease/kcapture.1 One can interpret Vmax/Km as an effective rate of 

capture of substrate by the enzyme (Northrop 1998; Northrop 1999). 

Exercise: Use Madonna to plot the MM function by writing the equation directly into 
the Equation Window and setting S = TIME (or RENAME TIME = S). Use 
the BATCH mode so that you can plot several different curves with different 

parameters. Start by holding Km constant at 10 mM for different values of 

Vmax, and show that v = vmax/2 only when S = Km. Next hold Vmax fixed at 

10 and allow Km to vary. The higher the Km the slower the rise in V—i.e. 

the longer it takes to get half way. In fact, Km = S1/2 = concentration when 

the reaction velocity is Vmax/2. To see how Km affects the shape of the 
curve, (i) make a slider to vary Km, (ii) Use the BATCH RUNS option make 
a parameter plot with various Km. 

Exercise: In practice, biochemists determine the MM function by plotting the initial 
appearance of product. Plot the reaction velocity (i.e. the flow into the P 
reservoir, Reaction 2) for 30 values of the initial substrate concentration 
(INIT S) (see Figure 7).  

 
 

Figure 7. Plot of reaction velocity (dP/dt) vs. initial substrate concentration (INIT S) using the 

Parameter Plot dialog. 

                                                

1 See, for example: Stryer, L. (1995). Biochemistry. New York, W. H. Freeman.. 
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Modeling systems with MM kinetics: Feedback 

regulation in thyroid-pituitary secretion 

We illustrate the use of MM 

reactions to simulate the regulation 

of the thyroid gland secretion. This 

system also illustrates the role of 

thyroxine feedback on TSH 

secreting cells of the anterior 

pituitary gland. To illustrate the 

principles involves we will only 

consider two hormones, thyroxine 

(TH) and thyroid stimulating 

hormone (TSH). Thus we will 

neglect most of the intricacies of 

iodine metabolism. 

 

Stimulation of thyroid secretion by TSH 

We model the secretion of TSH by a MM function: 

Equation 6  TH
SECR

=
Q
max

TSH[ ]

K
TSH

+ TSH[ ]
  

where Qmax = maximal rate of TH secretion, and KTSH = 

concentration of TSH required for 50% maximal TH secretion. 

Removal of TH 

Metabolic and/or renal clearance is assumed to be proportional to [TH], where [TH] denotes the 

concentration of free TH and the concentration of TH bound to plasma protein. Since [TH] is 

proportional to the total mass of TH, mTH, we can write 

Equation 7  THremoval = RTH mTH        

where RTH is a rate constant i.e. 1/time constant [day
-1

]. 

Inhibition of TSH secretion by TH: 

Equation 8  TSH
SECR

=
S
max
K
TH

n

K
TH

n
+ TH[ ]

n
 

Equation 9  TSHREMOVAL=RTSH TSH 
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where Smax = the rate of TSH secretion in the absence of TH, and KTH = the concentration of TH 

required for 50% maximal TSH inhibition.  

Parameters 

Because the bound TH and the free TH are proportional to each other, assuming a steady state is 

not a serious compromise. For normal humans in a steady state:  

THsecr = 80 g/day TSHsecr = 110 g/day 

[TH]ss = 80 g/liter [TSH]ss = __________ 

[TH]half life = 6.5 days [TSH]half life = 1 hour 

Volume of distribution of thyroid hormone = 10 liters. (This includes the TH bound to 

plasma protein—which soaks up the hormone as if there were an additional volume 

available.) 

Volume of distribution for TSH = 3 liters. (This is the volume of plasma—a guess—

TSH is a protein, not bound to other plasma proteins) 

 

Exercise: Estimate the remaining parameters for this simulation (see the Appendix) 

• RTH: compute the value from [TH]half life 

• RTSH: compute the value from [TSH]half life 

• [TSH]ss: Use the known value of TSHSecr (see Table) and compute the steady 

state value, [TSH]SS, using the steady state condition (Secr = Removal) 

• Smax and KTH: assume KTH is the steady state value of [TH] and compute Smax 

• Qmax and KTSH: assume KTSH = steady state value of [TSH] and compute 

Qmax 

• Assume: n = 3 

Exercise: Run the simulation for 50 days using initial values of [TH] = 30 g/liter, and 
[TSH] = 1 g/liter. Plot both [TH] and [TSH] and determine their "normal" 
steady state values. Are they consistent with the data? Note how fast the 
feedback system operates. Compare with different values of n. [Hint: [TH]ss 

= 80 g/l; if you don’t get this, check your parameter values carefully. 

Exercise: A patient suspected of chronic hypothyroidism has blood samples taken 
every few days and the averaged measured levels of [TH] = 36.7 g/L and 
[TSH] = 4.6 confirm the original suspicion. [TH] level is low, but because 
[TSH] is too high, the thyroid deficiency may be due to a reduced affinity of 
the TSH receptor (increased KTSH ), or a deficiency of the total number of 

TSH receptors, or of TH secretion (a decreased Qmax). Show that the latter 

assumption (defective Qmax) will account for the data. 
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Exercise: A physician wants to compensate for low levels of TH (in the patient 
described above) by administering daily doses of TH. What dose should he 
use? (Simulate the daily dose with the pulse function). 

Handling long chains is easy using arrays 
If a chain of reservoirs is more than 4 or 5 long, the Flowchart becomes unwieldy. If all of the 

transitions are identical then there is an easier way to enter a long list of identical differential 

equations: use Berkeley Madonna’s array notation. Consider the following chain of irreversible 

reactions: 

A1  A2 . . .  Ai  ...  An 

Instead of defining n compartments as A1, A2,…An, we can define an array A[1..n] that contains 

n entries. We can access any one entry by using the notation A[i]; for example, the 5
th

 entry in 

the array is A[5]. Assume that at time zero we introduce 100 units of A1 into the first 

compartment of the system. Then the equation for the first compartment is: 

d/dt (A[1]) = k[1]*A[1], INIT A[1] = 100. 

Notice that we have also introduced an array of rate constants: k[1..n] for the transitions between 

compartments. The equations governing all of the compartments from 2 up to n-1 can be written 

simply as 

  

d /dt (A[2..n]) = k[i 1]* A[i 1]

Flow into compartment i
from compartment i - 1

       
k[i]* A[i]

Flow out of compartment i
to compartment i + 1

     
 

The initial conditions for all 2,…n compartments can also be set in one step: INIT A[2..n] = 0. 

Finally, the last compartment has only an inflow: 

d/dt (A[n]) = k[n-1]*A[n-1] 

Thus the equation window for this system looks like that in Figure 8.  

To plot the contents of all the compartments, choose the variable A[] from the Graph dialog 

window. To plot the contents of any compartment, define a variable Ax = A[m]. Then you can 

make a slider with m as a variable so scan through the graphs of each compartment. Another 

slider for the number of compartments, n, lets you see how the system behaves as the number of 

compartments is varied. Note that for large n, the graph of the last compartment, A[n], is 

sigmoidal, indicating the time delay between introducing substance into the first compartment 

and when it shows up in the last compartment. 
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Figure 8. Equation and Graph windows for the linear array of compartments. 

Exercise. Change the model in Figure 8 so that all transitions except the last are 

reversible: A1  A2 . . .  Ai  ...  An. That is, connect each pair of 

neighboring compartments by forward and reverse flows. Make sliders to 
view the contents of the first and last compartments and one to vary the 
reverse rate constants. Compare the solutions for reversible and 
irreversible reactions. 
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Appendices 

The Flowchart is not convenient for representing chemical reactions 

The Flowchart and equations for the reaction A + B  C is shown in Figure 9. In order to make 

the Flowchart resemble the reaction equation we have had to introduce a separate reservoir for 

the ‘complex’ formed by A and B before they combine into the product, C: x = A B. Moreover, 

the flow into reservoir C has to be halved because conservation of mole numbers (Equation 11) 

would require that a mole efflux from reservoirs A and B would add to make two moles entering 

reservoir x, and thence to reservoir C: J3 = k3*x/2 (see the equations in Figure 9). Thus the 

flowchart must be altered in ways that appear somewhat artificial. This reflects one of the 

limitations of representing chemical systems using the Flowchart interface. The Flowchart 

becomes even less intuitive when the stoichiometric coefficients are not unity. Therefore, for 

chemical reactions, the Chemical Reaction module is a much more efficient way of setting up 

model equations than the Flowchart. 

{Reservoirs} 
 d/dt (A) = - J1 
 INIT A = 100 
 d/dt (B) = - J2 
 INIT B = 50 
 d/dt (x) = + J2 + J1 - J3 
 INIT x = 0 
 d/dt (C) = + J3 
 INIT C = 0 

{Flows} 
 J1 = k1*A*B-(k2+k3)*x 
 J2 = k1*A*B-k2*x 

 J3 = k3*x/2 

{Functions} 
 k1 = 0.002 
 k2 = 0.001 
 k3 = 0.1 

Figure 9. Flowchart for the reaction A + B  C. Note the halving of the flow, J3, to 

compensate for the lack of stoichiometry in the flows out of A and B into C. 

Guesstimating  parameters from data 

1. Assume the process is ‘first order’ (i.e. exponential rise or 

decay):  

   Rate constant k ~ 0.69/t1/2 

2. Assume a steady state (dx/dt  0) and use the resulting algebraic 

equation to eliminate one parameter. 

3. If S is a ‘regulated’ quantity, then assume that at steady state 

S ~ K
m

(this ‘rule of thumb’ is expected to be accurate only to 

an order of magnitude).  
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Stoichiometry 

Consider a chemical reaction wherein 1 moles of reactant N1 combines with 2 moles of 

reactant N2 to produce 3 moles of product, N3. (Or, conversely, R3 dissociates into 1 moles of 

reactant N1 and 2 moles of reactant N2.): 

Equation 10   1 N1 + 2 N2  3 N3  

For example, in the reaction 2H2 + O2  2H2O the stoichiometric coefficients, i, are (3, 1, 2); 

they give the proportion of reactants and products, e.g. 3 moles of O2 per 2 moles of H2O.  

Although there are three reactants, there is only one reaction, and the reactants are constrained to 

appear and disappear in accordance with the stoichiometry, a reflection that the reaction 

conserves the total mass of reactants. Therefore, we can define a variable that measures how far 

the reaction has advanced, or the extent of reaction, which we denote by x, the advancement 

(Katchalsky and Curran 1965). Whatever the time course of the individual reactants during the 

reaction, the rate reactants disappear and products appear are constrained by the stoichiometry: 

Equation 11    
1

i

dNi

dt
=
1

j

dN j

dt
=
dx

dt
 

The rate at which a reaction proceeds in a well-stirred volume V can be described by a set of 

differential equations in the molar concentrations, ci = Ni/V 

Equation 12   dci/dt = i( 1c1, 2 c2, 3 c3, , p,…), i = 1,2,3 

where T and p are temperature and pressure, which are generally considered constant in 

biological systems, and i are the stoichiometric coefficients. The rate functions, i( ), are 

empirical or theoretical functions that depend on the model. The simplest and most widely used 

model describes the reaction rate according to the law of mass action, although it is not a ‘law’, 

but simply a useful approximation. For unimolecular reactions (e.g. A  B) the equations are 

linear: 

Equation 13   
dx

dt
= k x =

da

dt
=
db

dt
  

where k is a rate constant. For bimolecular reactions (e.g. A + B  C), the equations are 

quadratic: 

Equation 14   
dc

dt
= k

+
a b k c  

where lower case letters are the concentrations of the reactants.  

Cooperative reactions 

The MM curve is hyperbolic, characteristic of simple enzymatic reactions. One frequently 

encounters reaction velocity curves that are sigmoidal, indicating some sort of cooperativity. The 

simplest example of this is and enzyme that has two conformations, denoted (C1, C2), depending 

on whether it has bound one or two substrate molecules. Thus the enzyme has three states: 

empty, one substrate bound, and two substrates bound: 
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Equation 15  

E + S
k
1   

k
1

   C
1

k
2   E +P

C
1

+ S
k
3

   
k 3

   C
2

k
4   C

1
+P

 

The equations governing these reactions are written exactly as for the MM kinetics. The 

conservation equation for the enzyme is E + C1 + C2 = E0, so that we can eliminate one equation. 

Morever, the equation for the product can be solved independently of the rest of the kinetics once 

E and C1 are known. Therefore, we need only write equations for S, C1, and C2. 

Exercise. (a) Write the model equations for the reaction scheme in Equation 15 in 
terms of S, C1, and C2, taking into account the conservation equation for the 
enzyme. (b) Use the same approximation as in the MM model for the 
complexes: dC1/dt = dC2/dt = 0 to solve for C1 and C2. From this, write the 
equation for the reaction velocity V = k2C1 + k4C2 (Keener and Sneyd 1998, 
p. 12): 

Equation 16 v =
k
2
K
2
+ k

4
S( )E0

S

K
1
K
2
+ K

2
S + S

2
, where K1 = (k-1+ k-2)/k1, K2 = (k4+k-3)/k3 

Cooperativity means that binding of one substrate increases the binding rate 
of the second substrate. Use Berkeley Madonna to plot Equation 16  when 
K1 = 103, K2 = 10-3, E0 = 1, k2 = 1, k4 = 2. Use sliders to vary K1 and K2 till 
the sites are independent: K1 = 0.5, K2 = 2. 

Plotting indeterminate functions with Berkeley Madonna  

Berkeley Madonna is not a powerful plotting program so you must be careful when graphing 

functions that are ‘indeterminate’, i.e. have terms like 0  or 0/0, etc. For example, the formula 

for the free energy of mixing two solutions is 

G

RT
= x ln(x) + (1 x)ln(1 x) + x(1 x) 

where 0  x  1 is the mole fraction, RT is the gas constant times the absolute temperature, and  

measures the attraction between molecules of the two substances (Dill and S. Bromberg 2003, 

chapters 15 & 25). This function is not determinate at x = 0, 1, and Berkeley Madonna does not 

know how to compute L’Hospital’s rule to determine the values there. So you must set the 

plotting interval to avoid such points, as shown in Figure 10. A more powerful plotting program, 

like Mathematica™ or Maple™ knows how to handle such functions. 
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Figure 10. Graph of the function G  x ln(x) + (1  x) ln(1  x) + x(1  x) that is 

indeterminate at x = 0, 1. Berkeley Madonna will not compute L’Hospital’s rule to 

determine the values at these points, so you must set the plotting interval to avoid 

them. 
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Web resources 

• UBC Online calculus course:  

http://www.ugrad.math.ubc.ca/coursedoc/math100/notes/index.html - mordifeqs 

• SOS Mathematics! An online tutorial for math: 

http://www.sosmath.com/index.html 

Euler’s Method: http://www.sosmath.com/diffeq/first/numerical/numerical.html 


